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OVERVIEW 
 

The UCS-10 is a fully integrated multichannel analyzer for nuclear 
spectroscopy and time related studies on the Macintosh computer. The 
instrument contains a high voltage supply, amplifier, multichannel scaling, a 
1024 channel analog-to-digital converter and 4096 channels of data memory 
divided into 4 x 1024 channel segments called buffers, capable of storing 
separate spectra and associated elapsed time. 

UCS 10 - Menus 
File 
New - Opens a blank window that is not associated with any hardware or 
opened file. This window may be used to hold a spectrum pasted from the 
clipboard. 
Open - Opens a UCS spectrum file in its own window or a UCS setup file 
containing all acquisition parameters and presets. Both file types will appear in 
the standard Open File dialog box. The spectrum files are represented by 
document style icons showing a miniature spectrum. Setup files are document 
style icons filled with simulated controls and indicators. 
Select Active UCS Buffer - The UCS-10 contains four separate spectrum data 
buffers. Each buffer maintains its own data and elapsed times. All four buffers 
use the current amplifier and ADC settings. Data may be accumulated in only 
one buffer at a time. This selection activates a buffer and opens a window for 
its data if one is not already open. If more than one buffer window is open, 
mouse clicks will activate the windows normally. However the only buffer that 
is able to acquire data is the one selected from this menu choice. The selected 
buffer and the SCSI address of its UCS is always displayed under the acquire/
erase controls in the system control window. 
Close - Closes the current spectrum data window. 
Save - Standard data file saving. 
Save As - Standard data file renaming or changes saving. 
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Version 1.30 Software Disk 
This disk contains the following items: 
              UCS for Mac version 1.30 - This is the MCA application program for 
              the UCS-10 system. 
              SCSI Tools - This application may be run to determine where SCSI 
              devices are currently connected to the Mac. 
              Cs137-Co60 - This is a spectrum acquired using the UCS-10 and 
              saved to disk. It may be opened and viewed from within the UCS for 
              Mac application. 
              UCS Settings. This is a sample UCS Setup file holding high voltage, 
              amplifier gain, presets etc. 
              UCS Notes. A text file with latest additions and corrections. 



Save Settings - This selection will save UCS setup parameters including 
detector voltage, amplifier gains, presets, etc. 
Page Setup - Standard print out set up. 
Print Preferences - The check boxes select or deselect the print out features. 
The selection of the channel data will cause all channels between the first and 
last selections to be printed.  
Print - Activates printing as defined in Print Preferences. 
Quit - Exit the UCS for Mac application. 
 
Edit 
Cut - Erases spectrum in current window and copies data to clipboard in the 
same formats as the Copy selection. 
Copy - This selection copies the currently selected spectrum into the clipboard. 
Spectrum data may be directly pasted into another spectrum data window from 
the clipboard. Clipboard data also exists in tab separated ASCII format for 
direct pasting into spreadsheets or documents. 
Paste - Pastes spectrum data into the current window. 
Clear - This selection erases the spectrum in the front window even if the 
window shows a spectrum loaded from disk. Note that this is not possible 
using the Erase control in the system control window. 
Copy Data Only - This selection only copies to the clipboard the ASCII 
channel data with no header or column titles. 
Strip Clipboard Spectrum - Allows the spectrum currently residing in the 
clipboard to be subtracted channel by channel from the spectrum in the current 
data window. This is done using livetime normalization. 
Add Clipboard Spectrum - Allows the spectrum currently residing in the 
clipboard to be added channel by channel to the spectrum in the current data 
window. 
Experiment Text - Allows user information about the spectrum being collected 
to be entered and tagged with the spectrum. 
Show Clipboard - A simple clipboard text viewer. 
 
 
Mode 
Pulse Height Analysis - Sets system into standard PHA mode (default). 
Multichannel Scaling - Sets system into MCS mode where incoming events 
are counted for predetermined (Dwell) times and stored in sequential memory 
channels. This selection counts all events occurring between the upper and 
lower level discriminators. These are set using the sliders above the spectrum 
area in PHA mode. 
External Multichannel Scaling - Same as above except that events are 
counted from rear panel external MCS connector. 
 
Calculations 
Energy Calibrate - This selection changes the system control window to 
energy calibration display to allow the system to read channels in energy units. 
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Two (linear fit) or three (quadratic fit) points may be used do the calibration. 
The works by positioning the marker in a channel and clicking Energy to enter 
the energy for that channel. The radio buttons indicate which of the three 
points is being set. The energy units may also be set. When at least two points 
have been completed, clicking on Calibrate will do the calibration calculation 
and the marker and X axis can then be read in energy. 
Spectrum Smooth - This selection does a three point averaging of the data. The 
new data will be displayed. The actual data collected in the hardware will not 
be affected and may be retrieved by choosing Raw Data or continuing 
acquisition. 
Raw Data - Retrieves the true spectrum data after a smooth selection. 
 
Tools 
IsoMatch - The IsoMatch feature places markers in the spectrum window 
showing the significant gamma ray emissions for many common isotopes. This 
feature requires a properly energy calibrated spectrum so that the markers will 
not be misaligned. When this feature is selected a list box appears with the 
currently present isotope list. Use the mouse to click on isotopes to be labeled. 
To select multiple isotopes, hold down the Command key while clicking on an 
isotopes. 
The isotope list and the corresponding energies may be edited by the user using 
ResEdit on the UCS for Mac application. Up to 128 isotopes may be added 
each with up to 5 energies. 
Peak Summary - If regions of interest (ROIs) are currently set this selection 
changes the data display from spectral to text giving the summary information 
for each ROI. 
 
Settings 
View Settings - This selection displays a dialog box showing all the UCS 
hardware parameter settings. If the front window displays a spectrum loaded 
from disk, this dialog shows the parameters used to collect that data. The 
dialog may be exited with no action by clicking OK.  
Presets - Several acquisition presets may be set when in standard PHA mode. 
After presets are set acquisition may be started and will stop automatically 
when the first preset is reached. Preset real and live times are available as well 
as preset peak counts and preset integral. When preset peak counts is selected 
the first channel to reach this number of counts will stop acquisition. Preset 
integral must be set while the marker resides in region of interest. When the 
counts in that region reach the preset value acquisition will stop. Note that the 
region will consist of all regions of the spectrum that are of the same type 
(color). To individually activate or deactivate presets use the check boxes in 
this dialog. 
Dwell Time - In MCS or EMCS modes only this selects the time that events 
are counted in each channel. 
Amplifier/High Voltage - This allows the coarse/fine gain and high voltage to 
be adjusted. The acquisition controls are made available within this dialog box 
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for convenience. 
Conversion Gain - Sets the ADC full scale conversion channel. 
ROI Indicator - Drag the mouse to the color/pattern of choice to make it the 
new active ROI type. All subsequent ROI settings will use this color/pattern 
until it is changed. 
 
 
Window 
Stack - Stacks vertically all open spectrum windows. 
Tile - Tiles all open spectrum windows. 
Window List - Provides access to selecting spectrum windows. 
 

Other Features and Controls 
Acquisition Controls 
Acquisition in any mode may be started by clicking the Acquire check box in 
the system control window. Small indicators will blink when acquisition is on. 
Clicking on the check box again will stop acquisition. To erase all acquired 
data click the Erase button. This does not clear any regions of interest that have 
been set or any current acquisition presets. 
 
 
Regions of Interest (ROIs) 
Region of Interest selection provides instantaneous computation of peak gross 
and net counts. To set a region of interest click on the Set radio button in the 
system control window. The currently selected ROI color type will be 
displayed to the right of the Set indicator. Move the mouse to the left side of 
the spectrum area to be selected. Click and drag across the spectrum to the 
right until the right side of the desired region is reached. Release the mouse 
button and the enclosed area will highlight as a region of interest. To clear a 
region click the clear radio button and click and drag the cursor across  a 
region. Release the mouse button and all channels marked as ROIs between the 
drag boundaries will be cleared. To quickly clear all ROIs select Clear and 
click the spectrum erase button. Only ROIs will be cleared. The data will 
remain. After setting or clearing ROIs be sure to click the Normal  ROI radio 
button so that the marker will set or clear unwanted areas. 
 
ULD / LLD 
The upper and lower level discriminator settings are shown by the position of 
the sliders above the spectrum display area of a spectrum window. They may 
be changed by clicking and dragging these indicators.  
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INSTALLATION 
 

Your UCS-10 Universal Computer Spectrometer is designed to interface to 
most Macintosh computers running System 7 or higher. Communication is via 
the SCSI interface, so it will be necessary to first determine an unused SCSI 
address. 
Before connecting the UCS-10 to the Macintosh, insert the UCS for Mac disk 
and run the small utility “SCSI Tools”. A window will appear with a row of 
eight indicators that correspond to the eight possible SCSI addresses that the 
Macintosh can accommodate. As SCSI devices are found the indicators for 
their SCSI addresses will “light up” . Typically two or three SCSI devices are 
already installed in the computer. The Mac’s internal SCSI controller will 
always show up at SCSI ID 7. If a CD-ROM drive is installed, it is typically at 
SCSI address 3. Some Macs contain one or more  SCSI hard drives and they 
are usually installed beginning at SCSI address 0. Note that the SCSI address 
for any device except the internal controller may be changed by the user, so 
your SCSI Tools display may not look exactly like this description.  
The UCS-10 may now be set to any unused SCSI address on your system using 
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8 7 6 5 4 3 2 1 

SCSI Address 

   0      1        2        3        4        5       6       7 

ON 

OFF 

Setting shown for SCSI address #4 

Setting the UCS-10 SCSI Address 
Note: The power to the UCS-10 must be OFF while setting the SCSI ID 
switches. 
 
Before connecting the UCS-10 SCSI interface cable to the Macintosh, 
determine a SCSI address to use as described above. Turn the UCS-10 over so 
that you are looking at the bottom of the chassis with the front panel facing to 
the rear, notice the small slot giving access to a row of eight switches. The 
switches are numbered 1 through 8. Switch 1 corresponds to SCSI address 0 
and switch 8 corresponds to SCSI address 7. The switches are activated when 
they are in the OFF position. There may be one and only one SCSI ID switch 
active on the UCS-10. Select an unused SCSI address and place the 
corresponding switch in the active (Off) position. Make sure all other switches 
are inactive (On). Connect a Macintosh SCSI cable to the UCS-10 from the 25 
pin SCSI connector on the back of the Macintosh. 
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WARNING - ELECTRICAL SHOCK HAZARD 
 

TO AVOID ANY POSSIBILITY OF ELECTRICAL 
SHOCK, ALWAYS TURN OFF THE COMPUTER 
POWER BEFORE CONNECTING THE EXTERNAL 
CABLES. DANGEROUS HIGH VOLTAGE CAN 
EXIST ON THE THE EXTERNAL HV CONNECTOR 
WHEN THE UNIT IS OPERATING. NEVER REMOVE 
OR CONNECT CABLES WITH THE COMPUTER 
RUNNING. 
SERVICE BY AUTHORIZED PERSONNEL ONLY. 

Connecting the Detector. 
 
The UCS-10 is equipped with an internal Amplifier/Preamplifier allowing 
direct connection of a scintillation detector. If you plan to use this feature, 
connect the signal (anode) output of the detector tube base to the PREAMP IN 
connector on the rear of the instrument using a BNC cable and connect the 
high voltage to HIGH VOLTAGE with a MHV cable. 
 
These connectors appear similar with the MHV being.slightly longer than the BNC 

When using an external amplifier system, connect the amplifier unipolar or 
bipolar output to the DIRECT IN connector. 

Software Disk. 
 
This disk contains the following items: 
              UCS for Mac version 1.20 - This is the MCA application program for 
              the UCS-10 system. 
              SCSI Tools - This application may be run to determine where SCSI 
              devices are currently connected to the Mac. 
              Cs137-Co60 - This is a spectrum acquired using the UCS-10 and 
              saved to disk. It may be opened and viewed from within the UCS for 
              Mac application. 
              UCS Notes - This file. 
              UCS Settings. This is a sample UCS Setup file. 
 
The software is not copy protected and making a backup copy is recommended 
prior to installing the programs on the Mac hard drive. 
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High Voltage 
Indicator 

Computer 
Communication 

Acquisition 
Indicator 

Input Activity 
Indicator 

Auto-sensing Line Input 
90 to 240 VAC, 50 or 60 Hz. 

SCSI Connectors. 
Terminator may be required. 

High Voltage Output. 
Positive Polarity 

External Input 
to MCS 

Input for use with 
External Amplifier 

Input for direct 
connection to PMT 



OPERATION 
 
Once the program is running it will be necessary to configure the system 
parameters for correct operation and calibration. 
Place a gamma emitting check source near the detector face. Cs-137 is a good 
choice for many applications but other isotopes or combinations may be used. 
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Setting High Voltage and Gain. 
 
If you are using an integral NaI(Tl) detector with a voltage divider base such as 
the SPECTECH model GP-38, it will be necessary to set the high voltage and 
amplifier gain. From the menu bar select Settings, High Voltage/Amplifier. 
The following control box will appear. 



Set ADC Conversion Gain. 
 
The default setting is 1024 channels ( maximum gain ). This is preferred for 
most scintillation detector applications and generally no adjustment is required.  
For certain uses such as alpha spectroscopy, it may be necessary to change this 
parameter to either 512 or 256 channels. 
 
From the menu bar select Setting, Conversion Gain. The ADC conversion  
may now be selected as desired. 

Set LLD/ULD. 
 
At this stage it may be convenient to set the LOWER and UPPER 
discriminator levels to eliminate unwanted noise and high energy signals. If the 
LLD is set too low, detector noise may produce excessive system deadtime. 
Setting a counting window around a peak of interest can also be useful when 
performing decay studies using the MCS mode. 
 
The upper and lower level discriminators are shown by the position of the 
sliders above the spectrum display area. They may be changed by clicking and 
dragging these indicators. 
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Set the high voltage to the recommended operating value found on the 
manufacturers data sheet (normally around 500v for the GP-38).  

Click the ON  button. 
Set the amplifier coarse gain to 8 as an initial starting value and start 
acquisition by clicking the Start button. The UCS-10 should begin collecting 
data and a spectrum of the calibration source will build on the screen. Using 
the course and fine gain controls align the photopeak(s) to the desired channel
(s). 
If the 662 keV peak is set to channel 662, this will yield an approximate 
calibration of 1 keV per channel and a maximum energy range of 1.23 MeV 
which may not be sufficient for many experiments. Some measurements 
require an energy range of 2.8 MeV and the calibration should be set 
accordingly.  

Lower Level Discriminator Upper Level Discriminator 



Presets. 
 
Two preset time modes are available with the UCS-10 
 
PRESET LIVE TIME provides automatic correction for counting losses 
caused by the system deadtime. Events which occur during the pulse 
processing cycle are lost to the system so the timer is automatically updated to 
compensate for these losses. When operating at excessively high count-rates 
the deadtime meter will indicate a high value and the actual counting time may 
be more than doubled. Increasing the LLD setting can help reduce some high 
deadtime effects and is described later in this manual. 
 
 
PRESET REAL TIME sets the counting timer to run for actual clocktime and 
makes no correction for losses due to deadtime effects. 
 
Both the LIVE TIME and REAL TIME values are record on the UCS-10 
screen and saved in the file during data storage. 
 
 
From the menu bar select Setting, Presets. The following screen will appear. 
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Click the button to select the preset mode and enter the time in seconds. 
 
PRESET COUNT. 
 
From this menu you may also set a preset value for the current marker channel 
or the total counts in a region of interest where the marker resides. This mode 
can be useful for acquiring spectra with the same counting statistics. 
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Setting Regions of Interest. 
 
Regions may be set around areas in a spectrum to totalise the number of events 
that fall in each  region. Normally ROI;s are set around peaks of interest in 
order to determine the gross and net counts in each peak. ROI’s may be of 
different colors but should not overlap. 
SETTING ROI’s 
 
Click on the Set Button. 
 
Move the marker to the left edge of the peak. Click and drag the mouse over 
the peak and release the button. This will color the channels covered. Move to 
the next peak and repeat the process. A different color from the SETTINGS 
menu may be chosen if required. 
 
After all ROI’s are set, click the Normal Button. 
 
CLEARING ROI’s 
 
Click on the Clear Button. 
 
Move the marker to the left of the ROI. Click and drag the mouse across the 
ROI. Release the mouse button and all ROI’s in the drag boundaries will bee 
cleared 
To clear all ROI’s, click the Clear Button and click the main spectrum Erase 
Button. Only ROI’s will be cleared, the data will remain.After clearing ROI’s, 
click the Normal Button. 
When the marker is positioned in a ROI, the software computes the the gross 

Regions of Interest. 
 
Region of interest (ROI) selection is an advanced feature which provides 
instantaneous computation of peak gross and net counts. These values may be 
used along with isotope decay tables and detection efficiency to calculate 
absolute or relative isotopic activities. ROI’s must not overlap and be separated 
by at least one channel for correct area calculation. Up to 8 different groups of 
multiple ROI’s are possible using the color selector. Normally, peaks from a 
single isotope are marked in one color with separate colors used to differentiate 
different isotopes. 
Regions may be setup and cleared using the mouse controls. 



Gross and Net Integrals. 
 
When the marker is positioned in a region of interest, the UCS-10 software 
automatically calculates the gross and net area of the region. In order to 
minimize statistical effects at the ROI endpoints, a 3-point averaging  
technique is applied. The contents of channels (n-1), (n), and (n+1) are 
summed and averaged to derive the content of the endpoint channel for the net 
area computation. A linear interpolation is performed between these averaged 
endpoint values and counts below the Compton edge are subtracted to arrive at 
the net area of the peak. 
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and net integrals in the region and displays this data along with other computed 
information in the text area directly above the main spectrum display. 

NET Area 
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CALCULATIONS. 
 
The Calculations menu makes it possible to perform many advanced 
operations with the UCS-10. 
 
Energy Calibrate. 
 
The energy calibration feature allows the marker to read directly in energy 
units. Two calibration functions are possible, a 2-point linear, or a 3-point 
quadratic fit. In order to perform an energy calibration, it is first necessary to 
acquire a spectrum using known isotopes. Cs-137 together with Co-60 works 
well for many applications, producing gamma lines at 32keV, 662keV, 
1173keV and 1332.5keV. 
 

First clear any residual data from the calibration screen by clicking the Clear 
Button. 
 
Click the Units Button and select the units to be used. 
 
Position the marker at the highest channel of the first peak and click the  
Channel 1 Button. Next click the Energy Button and enter the peak energy 
value. Move the marker to the high point on the second peak to be used for the 
calibration and repeat the procedure. At this stage, if only a 2-point calibration 
is to be used, exit by clicking on the Calibrate Button If a 3-point calibration is 
required, continue by moving the marker to the peak channel of the third peak, 
enter its energy and click on Calibrate. The system will now be calibrated and 
the marker position will read directly in energy. 
 
To return to the channel mode, restore the menu and click the Clear Button. 
 
Spectrum Smooth. 
 
Selecting this feature performs a 3-point smoothing on the spectrum 
The smoothing function only works on the buffer currently being displayed 
and does not modify data stored in the UCS-10 memory. When executed, 
smoothing performs a 3-point averaging of the data using the algorithm  

(n-1)+(n)+(n+1). 
3 



Using the Memory Buffers. 
 
The UCS-10 contains four memory buffers each capable of acquiring and 
storing a 1024 channel spectrum with the elapsed time. These buffers may be 
used to store a background spectrum and other data spectra use for comparison 
and stripping. Data may be accumulated in only one buffer at a time. The 
buffers are accessed through the file menu. 
 
From File, select Active UCS Buffer and choose the buffer you wish to 
display. You may open several buffers at any time, but only the buffer being 
displayed will be active and capable of acquiring data. The selected buffer and 
the SCSI address of its UCS-10 is displayed on the system screen in the control 
window. 
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Spectrum Stripping and Background Subtraction. 
 
Spectrum stripping is method of subtracting one spectrum from another to 
show the residual. It is normally performed on a channel by channel basis 
using “Normalized Livetime”. If spectrum B has been accumulated for 1000 
sec. and spectrum A is accumulated for 100 sec., when spectrum B is stripped 
from A only 10% of the channel content of B is subtracted from A. 
This function can be useful for subtracting a background spectrum which has 
been accumulated over a long counting time from data accumulated over much 
shorter times.  
Stripping only effects the data in the display memory and never changes the 
contents of the UCS-10 memory buffers. To strip a spectrum you must first 
transfer the spectrum that will used for the stripping into the clipboard. 
 
From the Edit menu select the Active UCS Buffer of the spectrum that will be 
used for the stripping to display it on the screen. Copy the spectrum into the 
clipboard using Edit, Copy. Now select and display the spectrum to be stripped 
and from the Edit menu select Strip Clipboard Spectrum. The display window 
will now show the residual after the normalized spectra are subtracted channel 
by channel. 
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MULTICHANNEL SCALING. 
 

Multichannel Scaling provides a means of recording time correlated data such 
as half-life decay or single photon counting. In this mode the ADC is bypassed 
and incoming events are routed directly into memory.  
The UCS-10 is factory configured to use its internal amplifier and 
discriminators to process detector signals prior to routing to the MCS counter. 
This scheme presents a convenient method of counting the complete spectrum 
or a selected range such as a single photopeak.  
First acquire a spectrum of the sample to be counted using the Pulse Height 
Analysis mode. While acquiring the spectrum, adjust the LLD and ULD to 
select the energy range of interest (For example, selecting only the 662keV 
peak from Cs-137 can eliminate unwanted background and produce a superior 
decay curve from the Cs-137/Ba-137 generator.)  
 
From the Mode menu select MCS.  
 
Select the Dwell Time from the Settings menu for each memory location 
(channel). Remember the total pass time will be (1024 x dwell time). 
Erase any current memory data and click start. The ICS 10 will proceed to 
count incoming events for the selected dwell time, store the total in the first 
channel location, reset the counter and repeat the cycle storing each total in 
sequential channels. 
 
If you wish to use an external pulse generation system such as a coincidence 
circuit, it will be necessary to bypass the on-board amplifier and 
discriminators. This mode may be selected from the Settings, EMCS menu. 
When set to the EXT position, the input BNC connector is routed directly to 
the MCS counter. When operating in this mode, the MCS input requires 
positive TTL signals (>2.5v, >150ns duration).  

PEAK SUMMARY 
 
If regions of interest are currently set, a table of ROI data may be displayed by 
selecting the Peak Summary report. 
 
From the Tools menu select Peak Summary. 
 
The list of ROI data for the currently selected buffer will be displayed on the 
screen in place of the spectrum. Normal acquisition may be run while in this 
mode. 
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ISOMATCH. 
 
The IsoMatch feature proves a convenient method of quickly identifying 
isotopic peaks in a spectrum relative to a master library. When the isotope is 
selected from the library, markers with the associated isotope label are 
superimposed on the spectrum at the appropriate energy positions. 
Prior to running IsoMatch, the UCS-10 must be accurately energy calibrated 
otherwise the peak markers will be misaligned.  

To select IsoMatch Click Tools, IsoMatch. 
 
The IsoMatch library contains a listing of significant gamma ray emissions for 
many common isotopes. 
Select the isotope of interest and click Show. Markers will be superimposed 
over the spectrum at the corresponding energies of gamma emissions for the 
selected isotope. Multiple isotopes may be displayed simultaneously by 
selecting and clicking Show. The IsoMatch library may be edited use a 
resource editor such as ResEdit.  
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SAVING and PRINTING FILES 
 

Data files may be saved and restored in binary format from disk using the 
Save, Save As, and Open commands accessed from the File menu. 
 
A Save Settings command is also included which saves all current operating 
parameters such as high voltage, amplifier gain, ADC settings and presets. This 
feature can be very useful for saving and restoring specific setups and 
calibrations for different experiments. It also provides a convenient way of 
quickly restoring operating conditions after power has been removed from the 
UCS-10. 
 
Print Preferences provides a means of setting the data channels to be printed if 
the entire spectrum is not required to be outputted. 
 
Print sends the selected data to the printer. 
 

USING THE CLIPBOARD 
 

Data files may be pasted into another spectrum window or transferred in ASCII 
format to spreadsheets using the Clipboard function. Once in a spreadsheet, 
data may be manipulated and graphed for analysis and outputting to reports. 
Two copy commands are provided through the Edit menu. 
 
Copy. This command transfers the entire spectrum and header data to the 
clipboard. 
 
Copy Data Only. This command transfers only the spectrum channel data to 
the clipboard and is often preferred when moving data to mathematical 
analysis programs. Header information is not copied with this function. 
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SPECIFICATIONS 

Physical:  Fully shielded benchtop metal 
enclosure, 9x13x2.5 in. 
Preamp In:BNC connector for direct 
connection to PMT anode signal. Utilizes on-
board amplifier/preamplifier. 
Direct In: BNC connector bypasses internal 
amplifier and connects directly to ADC 
input. Accepts unipolar or bipolar signals 0-
8volt range, 
Ext MCS In:BNC connector bypasses 
internal amplifier Accepts positive TTL 
signals >150nsec., 5MHz aximum rate. 
HV Output:MHV (or optional SHV) 
connector supplies positive 0-1275volt @ 
1mA maximum current to power scintillation 
detector. High voltage is fully regulated and 
computer controlled in 5volt increments. 
SCSI:        50 pin SCSI-1 input and output 
connectors for interfacing to Macintosh. 
Amplifier:On-board combination preamp./
amplifier for use with scintillation detectors 
and PMT's. Computer controlled coarse and 
fine gain from x2 to x1000. 
ADC:        Wilkinson type with 80MHz 
clock and computer selected conversion gain 
of 1024, 512, or 256 channels. Direct input 
accepts pulse peaking times of 1sec. to 10sec. 
Includes deadtime correction when used in 
Live-Time mode. 
LLD & ULD:Independently computer 
controlled in 4-channel increments over 
entire input range. Operates prior to ADC for 
reduced system dead time. 
Modes:     MCA for pulse height analysis, or 
MCS for half-life decay or other time related 
studies. 
Timers:    Real-Time or Live-Time 
operation, selectable in 1sec increments and 
from 1msec. to 60sec. per channel in MCS 
mode. 
Data Memory:On-board dynamic RAM, 4 x 
1024 channel x 3 Bytes for data, plus region-
of-interest flag. 
Deadtime: System dead-time is computed 
and displayed on screen during acquisition. 
Power:      AC line, 100-250VAC, 50/60Hz, 
autosensing internal power supply with 
Universal Power Cord input. 
Status Indicators:High voltage, 
Communication, Acquire, Activity. 

System:    Operates under Macintosh System 
7 or higher. 
Display:    Color or monochrome monitor, 
Vertical scale adjust from 32 to 16M and 
LOG display. Horizontal 1024 channels with 
expansion  down to 128 channels. 
Time Mode:Preset live-time or preset real-
time selection. Both times are recorded and 
displayed. 
Count Mode:Preset count mode for selected 
channel or gross Region-of-Interest. 
ROI'S:      Multiple Regions-of Interest using 
color coding. 
Integral:   When cursor is in ROI, computes 
gross area, net area with end point averaging, 
centroid and FWHM. 
Energy Cal:2-point linear or 3-point 
quadratic converts cursor position reading 
directly to energy units. (Time units in MCS 
mode.) 
Subtract:  Subtracts channel-by-channel time 
normalized data stored in Clipboard from 
display data. 
Data Buffers:4x1024 channel buffers for 
storing spectra. Used with Spip and Overlap 
features.Overlays data memory spectrum 
with up to 3 additional spectra stored in 
Buffers. 
Smooth:    3-point smoothing of displayed 
data. Does not modify data in acquisition 
memory. 
Control:   Software control of High Voltage, 
Amplifier Gain, Lower and Upper level 
discriminators, and ADC Conversion Gain. 
File:          Save or load data file and header 
information in binary format. 
Clipboard:Clips data and header 
information, ROI data containing, centroid, 
FWHM, gross and net integrals, and header 
information in spreadsheet compatible format 
for transferring into other applications. 
ISOMATCH:Isotope library with peak 
markers and labeling for overlaying on 
spectrum. Provides quick isotope 
identification. Libraries may be edited and 
extended using Resource Editor. 
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